How to Make a Web Page
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What is the Internet, Really?

A series of Interconnected Networks form the Single Entity that We Know as the Internet
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What is the Internet, Really?
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Internet Service Provider
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Policies & Protocols

The W3C mission is to lead the World Wide Web to its full potential by developing protocols and guidelines that

ensure the long-term growth of the Web. Below we discuss important aspects of this mission, all of which further
W3C's vision of One Web.

www.w3.0rg

provide leadership in Internet related standards, education and policy.
We are dedicated to ensuring the open development, evolution and use .
of the Internet for the behefit of people throughout the world. WWW.ISOC.Org

The Internet Society (ISOC) is a nonprofit organisation founded in 1992 to soc,ety -\='"-
™

What they Do: ﬂﬁiw‘l" IUIOI’lIU §=IM
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Policies & Protocols

D NS (Domain Name System) maps names to IP addresses

I P Address (Internet Protocol Address)  Like a Postal Address
G -

But it is really even more
complicated than that

Individual to each device
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— Example IP Address in Binary Code:
897.00.14.901  Apple.com 11011000.00011011.00111101.10001001

187.67.23.809



What is a Web Page?

| Fireox= IR W1 ) B W ) I i..=inli Je Tech = | %

€)3/[B http//ele howstuffworks.com -||4- howstuffworks.com Py # B B
= works.com/tech - Mozilla Firefox "SI s i =TS

Search HowStuffWorks and the web

howstuffworks o o et e |

AdDiscovery y Video Podcasts Blogs Quizzes ‘- |

mm Culture Entertainment Home & Garden Money m Random Article
c c t i

2nd technology vou love to use. Explore computer, electronic and commwnication technologies in the Tech Chamnel.” />

Home > Tech

How a Cloud Antivirus Works

Cloud computing has opened a whole new world of storage and
Web interaction options for users, but is it the best way to protect

your computer?
'ju Computer How Cloud Computing Works
Virus Videos 10 Worst Computer Viruses of All Time | plasforn: 'local  keymond: (sc: | ChannelLanding! p: 0", o SN, £a%: ( (A5, cookiestaiSi, conkies  exiass ('esi_sega’) GEist

Mac vs. PC o Cloud Batteries Who invented
\ Antivirus . the cell
phone?

A Web Page is the visual representation of the html.

What you see when you type a URL into a browser and the web server returns the page back
toyou.
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s html?
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Home > Tech
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<meta http-equiv="imagetoolbar” content="no” />

goeta propererogieiper concencmraxcicler />
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techr />
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mputer. />
gadgets and technology you love to use.

Explore computer,

Tech Channel covers al:

<meta name="description” content=
<meta name="robots" content="noodp" />

en-us/default/misc/favicon.ico” />

1conn . p://stat

<link pe-

DailyStuff" title="How Stuff Works Feature Articles® />

lternate” t

pplication/rsstxml" href="hotp://

| <vLink re:

2008/£oml" xml:lang="en” lang="en” id="

Explore computer, electzonic and communication technologies

electronic and communication technologies in the

A simple Text file with html tags

1-npn plate-channell

in the Tech Channel.” />

html is a mark up language
that uses tags to format text
in a universal way that can

Tech Channel.” />
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<link ren" type=rappl: Prionixml® href="http:// 1c/m w1
<meta http-equiv="pics-label” content=" (pics-1.1 % = pics/vocabul gen true for
<link rel="meta” df xml" href="http: Lavens.caee +1810ewTCRA Labelsr 75

<soript type="text/javascript”>
/% <1[CDATAL */
window. ESH=window. HSW| | {};HSW.contentInfo={contentId: "5637407) ;

<poay
<soript type=rtext/3avascriptt>
7% <! [CoRTAL */
H5W. Loader. 1oad o2/,
(SOUSCORE peacon(c1:2, 276096204, cocn ek mmecs 1 hesebrn ets i
W s
CTatrions
ll <aiv ia="fo-root"></aiv>
<soript type"cext/javascriptt>
7= <t (conTat */
(funceson () (zunceson ac()
(vaz qsm()12 (HSK. cookies. extscs (*ac_seqs))
(qs=HSW. queryString.parse (HSH.cookies qo.segs. value) ;1

n.3s", function ()
"N

return gs.qel 1017}
HSW.ads. init ({cype: 'mix’ , Spoot: " =
791>/
</seript>

'+, plactorm: 'local’,

zos/cech’

<div class="page pageChannellanding layouti®>
<div class="neader headerChannellanding”>

<div class="noScreen”>

<ing src="htep://: en-us/defaulc/logos/discovery-attrib.gif" />

< I

/%
</script>

<link href=vhtep://: css/index/ Fhous252Fal) . caa3252C004252Fplugint252Fads . cast252C008252Fplugint2

<soript type=rtext, ptv sro="htep:/. 33/index/m/3query. 334252Chsu-t1c. J34252Caninalst252Fads . )54252Cnodal . ) s4252Cpane Hioves . J34252Cnavigation. 133252Cui4252Ftabs. )34252Cui 1262y
</nead>

Keyword: {to:'Channellanding’ ,p: 0" 0

then be interpreted and
displayed by the browser.

tophat.ces$252C008252Fplugini2S2Ec

"HSW!, re1: ( (HSW.cookiesssHSW. cookies. exists ('rei_segs') 44HST

IT IS a Mark Up language — controls how the browser “marks up” or displays the text on the screen
NOT a Programming Language- It does NOT use logic or performs functions



What is a Tag or Element?
___Opening and Closing

<htmI></html>

Opening tag Closing tag

*Mostly in Pairs but not always
There ARE exceptions

<br>

These tags surround the content and tell the Browser how to interpret it.



What is a Web Browser?

www.technology.lilithezine.com

Two Functions:
1. Speaks the same language so it’s able to Contact the Web Server and connect your machine
to the internet(work) and return the requested page to you
2. Interprets the HTML tags within the page and displays the page on your screen
as they intended to be viewed

Your browser
connects to a server =’|
and requests a page.
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The server sends
back the requested

SHIO)

p.g‘. — L
Your machine Server machine
running a Web running a Web
browser server

www.howstuffworks.com



All Browsers are NOT Created Equal

should | use Firefox?

Web Pages DO NOT Display the Same in all Browsers!

That’s why it is best to pick a popular one ;)

Hopefully soon they will all conform to w3c standards and it wont be an issue,
BUT for now TEST in multiple browsers but CREATE for the majority

Statistics are important information. And r°°|d 40‘;932?
From the statistics below (collected from W3Schools' log-files over a period of ten years), you 4 5 9 /° « o Other

can read the long term trends of browser usage.

www.technology.lilithezine.com

We see that Google Chrome, Firefox, and Internet Explorer are the most popular browsers
Y/ today.

Browser Statistics

2013 Internet Explorer Firefox Chrome Safari
August 11.8 % 28.2 % 52.9 % 3.9 %
E uy 11.8 % 28.9 % 52.8 % 36 % 1.6 % g
S =
& June 12.0 % 28.9 % 52.1% 3.9 % 1.7 % E
S may 12.6 % 27.7 % 52.9 % 4.0 % 1.6 % =
< o
S Aprl 12.7 % 27.9 % 52.7 % 4.0 % 1.7 % @
™M .g o . 9_.
2 March 13.0 % 28.5 % 51.7 % 4.1 % 1s% DBrowser usage on Wikimedia 3
: o
g February 13.5 % 29.6 % 50.0 % 41% 1.8 % September 2012 g
&)
2 January 14.3 % 30.2 % 48.4 % 42% 199 Usage share of web browsers =



What is a Client?

Reqguesters of a Service

WI ™M ] a I L] [ 2 | IMhttps://mai...=inIine&zw x lWUsage share of web br... = I 4 New HTMLS logo | ¢
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3 http://www.google.com/search?q=google&ie=utf-8&oe=utf-8&aq=t&rls=org.mozilla:en-US:official&cl

Goc ;gle

Q, Everything
@& Images
@ Videos
E& News
@ Shopping

More

Types of Clients Include:

| how to make a w

‘Advanced search

Web Browsers
Email Clients
Chat Clients

After all our online chats,
it's great to finally
meet you in person.

how to make a website

how to make a website for free
how to make a wooden pipe
how to make a white russian
how to make a wand

About 1,220,000,000 results (0.20 seconds)

Make Your Own Website - Publish Your Website in Minutes .
www.top10bestwebsitehosting.com
Get a Free Setup & Free Domain !
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What is a Server?

Provider of a Resource or Service

Delivers html Documents, Images, Style Sheets and Scripts to a Client

FTP- Hosts Information Types of servers include
File Transfer Protocol Like an Apartment Building web servers,
Rent = Hosting Fee ftp servers,

application servers,
database servers,
name servers,

mail servers,

file servers,

print servers,
terminal servers,
web services

Click Here to Share e

~  Cyberduck

www.geekgirlcamp.com

%+ Dropbox =

YOUSENDIt
*servers are not necessarily within
the internet- Some are contained
within devices
-
www.cyberduck.ch Composite Created by Images sourced from
www.dropbox.com Web Server: www.geeksofdoom.com

www.yousendit.com Apartment Building: www.runsbrooklyn.blogspot.com




Client-Server Model

Client Side Coding:
html
Forms

Images
CSS
JavaScript
Java

You don’t go to Google.com-after you send a tiny request, Google.com's home page comes to YOU

Server Side Coding:
Apache

PHP

MySql

&

=

you getsignal

Visual Trace Route Tool
approximate geophysical trace

FairPoint Communications
Get High Speed Internet For As Low as $17.99/mo. 1.877.509.8699
www.FairPoint.com/YourBusiness
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trace the path to a network

Remote Address [www.maine.edu | (Host Trace) (Proxy Trace)

" Use Current IP
Host Trace
@ yougetsignal.com == (& Remote Address
Proxy Trace
@ Your Computer — @ vougetsignal.com = (& Remote Address

www.yougetsignal.com

trace information

Proxy trace to

www.maine.edu

30 hops / 19.4 seconds
11. Unknown

E52. mcom

5 3. mcom

E=4. mcom

B 5. mcom

E56. 66.109.6.73

E=7. mcom

E=8. m.com

&5 9. rm.com

5 10. cogentco.com

=5 11. cogentco.com

5 12. cogentco.com

= 13. cogentco.com

= 14. dreamhost.com

—]15. dreamhost.com

== 16. dreamhost.com

S 17. cogentco.com

5 18. cogentco.com

25 19. cogentco.com

5 20. cogentco.com

= 21. cogentco.com

&5 22. cogentco.com

= 23. cogentco.com

& 24. cogentco.com

5 25. 38.104.187.146

5 26. maine.edu

E527. maine.edu

S 28. maine.edu

= 29. maine.edu

= 30. maine.edu

~5,388 miles traveled

Redraw Trace
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Web Page & HTML

To View Page Source: On a PC Right Click (John Wang Click) or Control + Click on a Mac

% UMaine NMDNet

- v
Version Control and its

News

John Bell and | have pointed out that version con
the incremental versions of an application as
production if adopted by other disciplines: Part ¢
like SourceForge.net meld project |...]

Poste Craig Dietrich

.| Got a camera? You car

2011
News

Cheap “fabbers” and easy-to-use photo-convers
working plane. Is 3d fabrication finally taking off?

"http://www.w3.0rg/1999/xhtml" di

<head profile="http://gmpg.org/xfn/11">
<meta http-equiv="Content-Type" content="text/html; charset=UTF-g8" />
<link rel="pingback" href="http://www.nmdnet.org/xmlrpc.php" />

<title>UMaine NMDNet</title>
<link rel="stylesheet" href="http://www.nmdnet.org/wp-content/themes/suffusion/style.css" type="text/css" media="all"/>
<link rel="stylesheet" hre:

http://www.nmdnet.org/wp-content/themes/suffusion/skins/light-theme-orange/style.css" type

[if !IE]>--><link rel="stylesheet" href="http://www.nmdnet.org/wp-content/themes/suffusion/rounded-corners.css” type="text/css" media="all"/><!--<!

href= t/themes/suffusion/ie-fix.

.org/vp

g.js"></script>

rdesign.vordpress.com/2009/07/02/belatedp:
—vidget ul 1i, #sideb

handling/

#sidebar-2 ul 1i,

docking boxes (dbx) by Bro
"text/javascript™>
/% <V[CDATA[ */
window.onload = function() {
//initialise the docking boxes manager
var manager = new dbxManager('main'); //session ID [/-_a-zA-20-9/]

.brothercake.com/ -->

//create new docking boxes group
var sidebar = new dbxGroup(

'sidebar’, // container ID [/-_a-zA-20-9/]

‘vertical', // orientation ['vertical'|'horizontal']

r7, // drag threshold ['n' pixels]

*no', // restrict drag movement to container axis ['yes'|'no']

10, // animate re-ordering [frames per transition, or '0' for no effect]
ryes', // include open/close toggle buttons ['ves'|'no']

‘open’, // default state ['open'|'closed']

‘open’, // word for "open", as in "open this box"

'close’, // word for "close", as in "close this box"

'click-down and drag to move this box', // sentence for "move this box" by mouse
'click to $togglet this box', // pattern-match sentence for "(open|close) this box" by mouse
'use the arrow keys to move this box', // sentence for "move this box" by keyboard
', or press the enter key to itogglet it', // pattern-match sentence-fragment for " (open|close) this box" by keyboard
'amytitles [idbxtitle:]' // pattern-match syntax for title-attribute conflicts
)i

3

/% 11> =/

</script>

<link rel="alternate" UMaine NMDNet &raquo; Feed" href="http://www.nmdnet.org/feed/" />
<link rel="alternate"” type="application/rss+xml" title="UMaine NMDNet &raquo; Comments Feed" href="http://www.nmdnet.org/ feed/" />
<script type='text/javascript' 0101110"></script>
<script type='text/javascript' ncludes/js/3query/jquery.js?ver=1.4.4"'></script>
<script type='text/javascript' /. nmdnet . org/wp-content/themes/suf fusion/scripts/suffusion. js?ver=:
EditURI" type="application/rsd+xml" title="RSD" href="http://www.nmdnet.org/xmlrpc.php?rsd” />

Vne="Ann1 1 cATion/Wlumani fesraxm] " hraf=thren: //uus amdnet. . ora/un—inclndes/wlumani festxmin />

.6.9"></script>

nag-catblock-post, input, .searchform .searchsubmit,

#right-neader-vidgets

"text/css" 1

1>

.searchsi




Anatomy of a Web Page: Body Metaphor

HTML, CSS & JavaScript

f //
/Qj‘ wf

ﬂ ,"_ .

W, :

The Skeleton/Bones
Basic Structure/How it’s Formed

G2

Style/ How it Looks

-JavaScript

The Muscles
Action/How it Works

Human Anatomy- EKAH6

www.connect.in.com



HTML

<html>
<head>
</head>
<body>
<div>
<h1>
</h1>
<p>
<br >
</p>
w </div>
</body>
</html>

T
e

www.officespam.chattablogs.com

skeleton daemon- Lo ha E | e m e nts = Ta gs

Always the Same - Just used in Different Combinations




CSS

v
( e CSS- Cascading Style Sheets

Selector Declaration Declaration

@ {color:blue; font-size:12px; }

Property Value Property Value

www.w3schools.com

Controls the appearance of HTML elements

Size {

POIS'Uon font-size:12px;

Color . text-align:center;

Font properties color:white;
font-family:“Calibri";
}

wwskinrejuvenationtoday.com



JavaScript

Actions = Muscles

JavaScript is the most popular scripting language on the internet
It is client side and written right into the html
Some words are pre-defined, but you custom-write the scripts and choose the variable names.

<script type="text/javascript'">
document.write("<h1>This is a heading</h1>");
document.write("<p>This is a paragraph.</p>");
document.write("<p>This is another paragraph.</p>");
</script>

Anatomy Chart courtesy of FCIT

www.fitstep.com

*NOT JAVA — that is totally different programming language



Tools: Sublime Text 2

What exactly is a Code editor?

Download uy Blog Forum Suppol

Sublime Text

Sublime Text is a sophisticated text editor for code, markup and prose.
You'll love the slick user interface, extraordinary features and amazing performance.

@00 . index.html UNREGISTERED.
index.html

DOCTYPE html
base64.cc

void base64_¢

size_t s1

size_t ds -

(s class=biop> Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video camera, and loads of fake
blood. Later she moved to Connecticut where she got made fun of for having a weird accent and learned to take pictures. After most likely
spending an unhealthy amount of time in the darkroom, printing a myriad of self-initiated projects, she received a BFA from the University
of Connecticut. Directly following she was off to New York City where she started her own business and worked as a commercial and editorial
photographer for over 10 years, while simultaneously developing her artistic vision.

class=biop> She has continued to shoot and publish work for clients that include: ATiamp;T, BBDO, Anglo Irish Bank, Phillips de Pury
Co., Random House, Pantheon Books, Gianluca Isaia, Tishman Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus, Velvet
Park, XLR8R, DIW, TRACE,
and L'ETOILE magazines.

N

class=biop-She has had photographs exhibited in group shows throughout the New York area, including one at the Brooklyn Museum and the
Museum of Sex in New York City. Her short film, Maypole, was an official selection of Independent Film Project's short film screening and
has been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program at the University of Maine and is
excitedly engaging in new creative territory.

it i st Always code in a code

<p>As an interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and transformational moments. By
reframing components of popular and often unquestioned rituals through the integration of performance, installation, textile, photography,

.
Fafraning copoasrts of polar s ofton astiseed rifinle Hroeh the Setaoration o pucformacs ialintion tertile, piotoure Editor! Pro grams suc h

viewer to challenge the roles society and self play in constructing identity and to rethink established conventions that are blindly
transmitted and reinforced through ritual behavior. </p>

.
<p> Through my in depth investigation of the wedding ritual, I raise questions about the expectations of perfection that are feverishly a S IVI IC roso I l WO rd a d d
propagated by the wedding industry and eagerly consumed and self-imposed by American brides. I focus on the iconography of the wedding

dress, which serves as a metaphor for the valorization of the quest for perfection in contemporary American wedding culture, and the

resulting perfection hysteria that often ensues as brides straddle public and private life, struggling to find a balance between personal

- s;|m|°" - decisions and societal expectations. </p> Fa n Cy fo rm a tti n g yo u

<img src= 9.1pg" alt="Wedding Portrait of by Adrian Buc
Photo by Adrian Buckmaster drianbuckm www, AdrianBuckmaster . com

i t : ; ?
Here 3D is used to don t Wa nt!

Download Sublime Text 2 FREE (Nagware)




w3schools.com

The best free resource out there

w3schools

http://www.w3schools.com/html/html| quiz.asp




w3schools.com

The best free resource out there

w3schools

http://www.w3schools.com/html/html examples.asp




Housekeeping

Organization

www.scarrabtek.co.uk



Naming Conventions

This is Important!

HELLO
my name is

http://

wWwWw.umit.maine.edu/

~jon_ippolito/bop/

thel5project.files.wordpress.com

You will be required to use these in this class
and in your subsequent classes here.



Showing File Extensions

On Your Computer: Mac

All Files

While Mac OS X hides file extensions by default, you can choose to show all file extensions,
overriding the "Hide extension" setting in the "Get Info" window. To do this, click on the desktop
to activate the Finder if is not already active and select "Preferences..." from the Finder menu.

r .,

S File Edit View Go
About Finder

Preferences... 38,

Empty Trash... ©#&
Secure Empty Trash

Services >
Hide Finder 3#H
Hide Others X #H
Show All

Then click on the Advanced tab in the Finder Preferences window as shown below:

een Advanced

General Labels Sidebar Advanced

™ Show all file extensions
@ Show warning before emptying the Trash

Finally, check the "Show all file extensions" box. All file extensions will now be visible both on the
desktop and in open windows. If you want to hide file extensions again, simply open the Finder
Preferences window and uncheck the box.

http://www.fileinfo.com/help/mac_show_extensions



Showing File Extensions

On Your Computer: PC

If you're using Windows Vista or 7

1. Click on the Start button > Control Panel > Appearance and Personalization > Folder Options (Two thoughts: [1] Boy, Vista is
a lot more complicated than earlier versions of Windows! [2] You can always use the Search box on the Start menu & just search for
"Folder Options" there, which may be the easiest option.)

2. In the Folder Options windows, click on the View tab.

3. Uncheck the box next to Hide file extensions for known file types.

General | View | Search

Folder views
You can apply the view (such as Details or lcons) that
g you are using for this folder to all folders of this type.

Apply to Folders Reset Folders

Advanced settings:

Files and Folders

["] Aways show icons, never thumbnails

[] Aways show menus

[¥] Display file icon on thumbnails

Display file size information in folder tips

Display simple folder view in Navigation pane

Display the full path in the title bar (Classic folders only)
Hidden files and folders
@ Do not show hidden files and folders
@ Show hidden files and folders

[ Hide extensions for known file types

Hide protected operating system files (Recommended)

4. Click OK to close the Folder Options window.

http://www.granneman.com/techinfo/windows/showextensions/




Showing File Extensions

On Your Computer: PC

If you're using Windows ME, Windows 2000, or Windows XP

1. On your desktop, open My Computer. If you don't see My Computer, then open any folder.
2. Select the Tools menu, & then select Folder Options ....

& My Computer

4 =101
| Ble Ede Vew Favorkes [ Took Heb
| €wcack - = - (3] | Qse  MepNetworkDrive... Eex »
| Address [\ my computer spii +] P=
g -
= @DUNIX (E:)
My Computer & Compact Disc (F:)
() Control Panel
Select anitem to view its @ Alake FTP & RDS
descripticn.
Displays the files and foiders on
your computer
See also
Enables you to change settings. VA
3. In the Folder Options windows, click on the View tab.
a.

Uncheck the box next to Hide file extensions for known file types (Note that I have checked and unchecked other boxes that
may not apply to you. If you would like to make your View tab resemble mine below, go right ahead; however, it is not necessary if
all that you wish to do is reveal the "dot 3" file extension.).

20
Goneral View | Fiie Types | Offine Files |
Folder views

“You can st all of your foldrs to the same view.

Reset Al Folders

Advanced seltngs
2] Files and Folders -
& Disp s and fodess with
[ Display the full path i the addvess bar
0 Display the full pth in e bax
(20 Hidden fies and foldess
© Do nct show Fidden fies and foiders
@ Show hidden fles and foldsrs
[ Hide fle extensons for known fle types
[ Hide protected operating system files [Recormended)
Lawnch foldes windows in  separate process
Remember each folder’s view setlings
nthe Desktop. =l

Restore Defaults
0K Cancel opl

5. Click OK to close the Folder Options window.
6. Close the My Computer window.

http://www.granneman.com/techinfo/windows/showextensions/




File Hierarchy

Organization

nmd100

Make a New Folder on your Desktop
Name it nmd100

*make sure to use only lowercase letters
**You will rename this later when you are assigned your own domain name

File image: www.content.etilize.com



File Hierarchy

Create 3 new folders

Name one “media”
The media folder will
contain all our media-
Images, graphics, logos,
audio & video.

Name the second one “css”

The tech folder will

contains our CSS (cascading style sheet)
Name the third one “js”.

(this would contain our JavaScript -if we were
Using that)

*make sure to use only lowercase letters

Always Organize Your Files

Within your nmd100 folder

media

Css

media:
Jpg .mov
.gif .ogg
.png .mpeg

.wav
.mp3
.aif

nmd100

js

CSS: Js:

.CSS Js



File Hierarchy

We will also need to put
Our html file in this folder

It does not nest inside
another folder.

We will name our html file
index.html

This is always named
Index.html

because it is the default
page the browser looks for.
(sometimes named
Home.html or
Default.html)

media

Css

Always Organize Your Files

nmd100

js

\
|/
index.html

index.html

File image: www.content.etilize.com



File Hierarchy

When typing in a URL

The browser automatically
defaults to the index.html
file and loads the home
page- (so you don’t have to
type it in).

If you did type it in you
would get the exact same
page.

Always Organize Your Files

€ )3
)

Wqﬂ 8| - |U|0[S|[S]w L) | %2 | *3 | [P] | @ Weather Foreca
http://\rv\rv\rv.wunderground.m
\ /

Main Site Mobile  iPhone Full Screen D)

£

wunderground.com®
Local Weather |

Underground*

Y Favorites

Welcome to W

You don

i

L

L

o

W

LIP3 | [P]

€ |4 \ http:// 1wwwunderground.com/inde@
N A—

& Weather Forec:

Main Site

Mobile

Weather Underground’

wunderground.com®

iPhone

Lite Full Screen 0

Y Favorites You dor

Welcome to W

Local Weather




File Hierarchy

Always Organize Your Files

If you do not name your file index.html you will have a different & more complicated URL

If you named your html file index.html
Your URL linking directly to it would be:
www.firstnamelastname.nmdprojects.net

If you named your file aboutme.html

Your URL would be
www.firstnamelastname.nmdprojects.net/aboutme.htmi



Index.html|

a Sample Index Page

Sublime Text 2
, -  File > New= File 2> Save As =

iﬁu_ index.html

— e — nmd100
‘ Sublime Text 2

® 0O &

index.html

Now Let’s add some Tags to our html file!



<ldoctype html>

Simple, Short & Sweet!
Before

<IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 10 Transitional//EN" A I l e r
"http://www.w3.org/TR/xhtmI1/DTD/xhtml1-transitional.dtd">

) <ldoctype html>
<html lang="en" dir="Itr" xmIns="http://www.w3.0rg/1999/xhtml|">

Definition and Usage: . _
The <IDOCTYPE> declaration must be the very first thing in your html document, @ Sublime Text 2
before the <html> tag. ** Make sure no white space on top.**

Note: The <!DOCTYPE> tag does not have an end tag. index.html
Tip: The <IDOCTYPE> declaration is NOT case sensitive doctype html

The doctype declaration is not an html tag; It is an instruction to the web browser about what version of the
markup language the page is written in. It is important that you specify the doctype in all HTML documents, so that
the browser knows what type of document to expect.



<ldoctype html>

Simple, Short & Sweet!
e MO

index.html

DOCTYPE html




<htmI></html|>

All other Tags Nest Inside the html Tags

Every HTML web page is enclosed inside <html>...</htmlI> tags
to notify the browser that the enclosed is HTML and not XML h
(or anything else). < tmb

<head>

No matter how long or short your HTML document is
Everything Including the head and body and everything in-
between goes inside these tags.

</head>
Within the <html> tags all the page content is contained bOd
inside two other basic tags: < y>
<head>...</head>
<body>...</body>

</body>

</htmly>



<htmI></html|>

All other Tags Nest Inside the html Tags

® OO

index.html

DOCTYPE html




<head></head>

www.fundraw.com

The head element is a container for all the head elements.

The head of the document contains:

-The page title

-Links to Cascading Style Sheets, JavaScript and/or links to JavaScript
-Metadata

-Description, keywords, author, content-type

<head>
<meta
<meta
<meta
<meta
<link

name="description” content="Demonstrate the head tag" />
name="keywords" content="HTML,(CSS,JavaScript” />

name="author" content="John Doe" />

http-equiv="Content-Type" content="text/html;charset=IS0-8859-1" />
href="default.css" rel="stylesheet" type="text/css" />

<script src="main.)js" type="text/javascript"/>
<title>Applied Web Design</title>

</head>

The following tags can be added to the head section:
<base>, <link>, <meta>, <script>, <style>, and <title>.

The <title> tag defines the title of the document, and is the only required element in the head section.




<head></head>

Processing Information
® N O

index.html

DOCTYPE html




<body></body>
Bod

The <body> tags define the document's body.
The body tags contain all the CONTENT of the web page

lists, links to audiovisual content (gif, jpeg, or png graphics,

Including: text, headings, paragraphs, links, images, form tags P !
. e l
video files, audio files or other media files), etc...

www.fundraw.com



<body></body>

Bod

® N O

index.html

DOCTYPE html




<head></head>

www.fundraw.com

The head element is a container for all the head elements.

The head of the document contains:

-The page title

-Links to Cascading Style Sheets, JavaScript and/or links to JavaScript
-Metadata

-Description, keywords, author, content-type

<head>
<meta
<meta
<meta
<meta
<link

name="description” content="Demonstrate the head tag" />
name="keywords" content="HTML,(CSS,JavaScript” />

name="author" content="John Doe" />

http-equiv="Content-Type" content="text/html;charset=IS0-8859-1" />
href="default.css" rel="stylesheet" type="text/css" />

<script src="main.)js" type="text/javascript"/>
<title>Applied Web Design</title>

</head>

The following tags can be added to the head section:
<base>, <link>, <meta>, <script>, <style>, and <title>.

The <title> tag defines the title of the document, and is the only required element in the head section.




<meta charset =“UTF-8" />

So humans can read it

BefO '@ <meta http-equiv="Content-Type” content="text/html; charset=UTF-8” />

Afte r <meta charset="“UTF-8” /> *How your browser takes binary code info and translates

HTML5-1.html * it into character encoding that you see on the screen
-1.html * x

1 <!DOCTYPE html> Examples
2 <html> Define keywords for search engines:
3 <head> <meta name="keywords" content="HTML, CSS, XML, XHTML, JavaScript" />
4 : <meta charset="UTF-8"/>
Define a description of your web page:
5 </head> <meta name="description" content="Free Web tutorials on HTML and CSS" />
6 - </html)

Define the last revision of your page:
<meta name="revised" content="Kai Jim Refsnes, 13/01/2011" />

Refresh page every 5 seconds:
<meta http-equiv="refresh" content="5" />

Metadata is data (information) about data.

The <meta> tag provides metadata about the HTML document.

Metadata will not be displayed on the page, but will be machine parsable.

Meta elements are typically used to specify page description, keywords, author of the document,
last modified, and other metadata.

The <meta> tag always goes inside the head element.

The metadata can be used by browsers (how to display content or reload page), search engines (keywords),
or other web services.



<meta charset =“UTF-8" />

So humans can read it

® OO

index.html

DOCTYPE html




<title></title>

Title

<title>Title of the document</title>

HTMLS5-1.html * x
1  <!DOCTYPE html)|

2H <html>

3 <head>

4 <meta charset="UTF-8"/>

5 <title>My Awesome Research Paper</title . S\ .
o </head> N | W L | = &My Awesome Research... x| +
THE <body> S i _ oa-

8 sheader>I can't wait to start writing my research paper.<br> g\ = file:///C:/Users/Amy/Des Cl 3 Google

9 It's gonna be awesome!</header> I can’ X . WP )

10 </body> cant watt to start writing my research Paper!

11 </html> It's gonna be Awesome!

*Different from the Header of your Page!
The Title is not visible on the web page itself

The <title> tag defines the title of the document and is required in all HTML documents.

The title element:

-Defines a title in the browser toolbar

-Provides a title for the page when it is added to favorites
-Displays a title for the page in search-engine results



<title></title>

™))

index.html

DOCTYPE html

charset="UTF-8

About Amy Pierce




® Sublime Text2 File Edit Selection Find View Goto Tools Project Window Help
9.0.0 « index.html @) Save
i OO, - A
index.html Save “index.html” already exists. Do you want
DOCTYPE html to replace it?
Save As: | index.htm| @ 1 E A file or folder with the same name already exists in
4 > — the folder nmd100. Replacing it will overwrite its
Cabrd fezi= bRmmmda00 | Q current contents.
= v i
— [&] Dre
ch:;se:—AUTF;i & Dropbox Dropbox S o = J ( Cancel ) Replace
out Am erce . De
Y .z | Desktop (-] nmd100 > ndex.htm ~— |
£ imfa WorkInProgres [ js L .
(- A media
;i—\ Applications (] media w}\ Applications [

" Documents
5 Downloads

SEARCH FOR
(L) Today

(5 Yesterday
(L) Past Week
(&] All Images

Ao aian -

( New Folder )

T
Cancel ( Save

I

File >Save As = index.html > Save > Replace

| Documents
J Downloads

SEARCH FOR
(L) Today

(Y Yesterday
(L) Past Week
(& All Images

(" New Folder )

—
( Cancel

| e——
[ Save




Preview!

Your index.html file

Drag your index.html file into Firefox to Preview it:

® Firefox File Edit View History Bookmarks Tools Window Help
®no About Amy Pierce

J About Amy Pierce @f — . .
G)Z] E] [ file:///Users/imfa/Desktop/nmd100/index.html The tltle tab WI” appear

The page will appear blank

because there is no content
Within the <body></body>

tags yet.



<body></body>

Bod

Copy and Paste your Bio & Creative Statements in-between the <body></body> tags.

® Sublime Text2 File Edit Selection Find View Goto Tools Project Window Help I\ €5 ER (M = 4) & 0:u
® 0O . index.html UNREGISTERED

index.html

DOCTYPE html

charset="UTF-8
About Amy Pierce

Bio

Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video camera, and loads of fake blood.
Later she moved to Connecticut where she got made fun of for having a weird accent and learned to take pictures. After most likely
spending an unhealthy amount of time in the darkroom, printing a myriad of self-initiated projects, she received a BFA from the
University of Connecticut. Directly following she was off to New York City where she started her own business and worked as a
commercial and editorial photographer for over 10 years, while simultaneously developing her artistic vision.

She has continued to shoot and publish work for clients that include: ATET. BBDO, Anglo Irish Bank, Phillips de Pury Random
ouse, Pantheon Books, Gianluca Isaia, Tishman Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus, Velvet Park,
XLR8R, DIW, TRACE, and L'ETOILE magazines.

She has had photographs exhibited in group shows throughout the New York area, including one at the Brooklyn Museum and the Museum of
Sex in New York City. Her short film, Maypole, was an official selection of Independent Film Project's short film screening and has
been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program at the University of Maine and is
excitedly engaging in new creative territory.

Creative Statement

As an interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and transformational moments. By
reframing components of popular and often unquestioned rituals through the integration of performance, installation, textile,
photography, videography, sound, graphic design, and audience engagement within the flexible parameters of structured created
narratives, I urge the viewer to challenge the roles society and self play in constructing identity and to rethink established
conventions that are blindly transmitted and reinforced through ritual behavior.

Through my in depth investigation of the wedding ritual, I raise questions about the expectations of perfection that are feverishly
propagated by the wedding industry and eagerly consumed and self-imposed by American brides. I focus on the iconography of the wedding
dress, which serves as a metaphor for the valorization of the quest for perfection in contemporary American wedding culture, and the
resulting perfection hysteria that often ensues as brides straddle public and private life, struggling to find a balance between
personal decisions and societal expectations.

Line 22, Column 576 Spaces: 4



® Sublime Text2 File Edit Selection Find View Goto Tools Project Window Help
9.0.0 « index.html @) Save
i OO, - N
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DOCTYPE html to replace it?
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Preview!

Your index.html file

Drag your index.html file into Firefox to Preview it
or Refresh your browser window if it is already open

® Firefox File Edit View History Bookmarks Tools Window Help

200 About Amy Pierce ! The title tab will appear

I\ About Amy Pierce @
@ @ [ file:///Users/imfa/Deskt c ] (}"' Google Q) @

Bio Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video
camera, and loads of fake blood. Later she moved to Connecticut where she got made fun of for having a
weird accent and learned to take pictures. After most likely spending an unhealthy amount of time in the
darkroom, printing a myriad of self-initiated projects, she received a BFA from the University of
Connecticut. Directly following she was off to New York City where she started her own business and
worked as a commercial and editorial photographer for over 10 years, while simultaneously developing
her artistic vision. She has continued to shoot and publish work for clients that include: AT&T, BBDO,
Anglo Irish Bank, Phillips de Pury & Co., Random House, Pantheon Books, Gianluca Isaia, Tishman
Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus, Velvet Park, XLR8R, DIW,
TRACE, and L'ETOILE magazines. She has had photographs exhibited in group shows throughout the
New York area, including one at the Brooklyn Museum and the Museum of Sex in New York City. Her H H

short film, Maypole, was an official selection of Independent Film Project's short film screening and has < Th e co nte nt Wi t h In t h e
been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program .
at the University of Maine and is excitedly engaging in new creative territory. Creative Statement As an < b (0] d y>< / b (0] d y> ta gS WiI I I
interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and
transformational moments. By reframing components of popular and often unquestioned rituals through a p p ear as one I a rg e
the integration of performance, installation, textile, photography, videography, sound, graphic design, and
audience engagement within the flexible parameters of structured created narratives, I urge the viewer to p ara g ra p h
challenge the roles society and self play in constructing identity and to rethink established conventions that ‘
are blindly transmitted and reinforced through ritual behavior. Through my in depth investigation of the
wedding ritual, I raise questions about the expectations of perfection that are feverishly propagated by the
wedding industry and eagerly consumed and self-imposed by American brides. I focus on the iconography
of the wedding dress, which serves as a metaphor for the valorization of the quest for perfection in
contemporary American wedding culture, and the resulting perfection hysteria that often ensues as brides
straddle public and private life, struggling to find a balance between personal decisions and societal
expectations.




Mark Up the Text!

Your index.html file

Now we need to mark up the text to tell the browser what is what-
to distinguish between Headings, Paragraphs, etc...

® Firefox File Edit View History Bookmarks Tools Window Help
®no About Amy Pierce 1

I\ About Amy Pierce [Tl
(% | [ @ file:///users/imfa/Deskt c | (33~ Googe Q) (M) ! Heading

Bio @MVMS with her sisters, the family video
camera, and loads of fake blood. Later she moved to Connecticut where she got made fun of for having a
weird accent and learned to take pictures. After most likely spending an unhealthy amount of time in the
darkroom, printing a myriad of self-initiated projects, she received a BFA from the University of
Connecticut. Directly following she was off to New York City where she started her own business and
worked as a commercial and editorial photographer for over 10 years, while simultaneously developing ( p ara g ra p h S
her artistic vision. She has continued to shoot and publish work for clients that include: AT&T, BBDO,
Anglo Irish Bank, Phillips de Pury & Co., Random House, Pantheon Books, Gianluca Isaia, Tishman
Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus, Velvet Park, XLR8R, DIW,
TRACE, and L'ETOILE magazines. She has had photographs exhibited in group shows throughout the
New York area, including one at the Brooklyn Museum and the Museum of Sex in New York City. Her .
short film, Maypole, was an official selection of Independent Film Project's short film screening and has / H ea d in g
been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program

at the University of Maine and is excitedly engaging in new creative territory. Creative Statement
interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and
transformational moments. By reframing components of popular and often unquestioned rituals through
the integration of performance, installation, textile, photography, videography, sound, graphic design, and
audience engagement within the flexible parameters of structured created narratives, I urge the viewer to
challenge the roles society and self play in constructing identity and to rethink established conventions that
are blindly transmitted and reinforced through ritual behavior. Through my in depth investigation of the ( p ara g ra p h S
wedding ritual, I raise questions about the expectations of perfection that are feverishly propagated by the

wedding industry and eagerly consumed and self-imposed by American brides. I focus on the iconography
of the wedding dress, which serves as a metaphor for the valorization of the quest for perfection in
contemporary American wedding culture, and the resulting perfection hysteria that often ensues as brides
straddle public and private life, struggling to find a balance between personal decisions and societal
expectations.




Mark Up the Text!

Your index.html file

We do this by wrapping the text in different tags to show meaning.

Everything you've always wanted to know about Amy Pierce
Bio

Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video camera, and loads of fake
blood. Later she moved to Connecticut where she got made fun of for having a weird accent and learned to take pictures. After
most likely spending an unhealthy amount of time in the darkroom, printing a myriad of self-initiated projects, she received a
BFA from the University of Connecticut. Directly following she was off to New York City where she started her own business and
worked as a commercial and editorial photographer for over 10 years, while simultaneously developing her artistic vision.

She has continued to shoot and publish work for clients that include: ATJr, BBDO, Anglo Irish Bank, Phillips de Pury J Co.,
Random House, Pantheon Books, Gianluca Isaia, Tishman Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus,
Velvet Park, XLR8R, DIW, TRACE, and L'ETOILE magazines.

She has had photographs exhibited in group shows throughout the New York area, including one at the Brooklyn Museum and the
Museum of Sex in New York City. Her short film, Maypole, was an official selection of Independent Film Project's short film
screening and has been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program at the
University of Maine and is excitedly engaging in new creative territory.

Creative Statement

<p>As an interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and transformational
moments. By reframing components of popular and often unquestioned rituals through the integration of performance,
installation, textile, photography, videography, sound, graphic design, and audience engagement within the flexible parameters
of structured created narratives, I urge the viewer to challenge the roles society and self play in constructing identity and
to rethink established conventions that are blindly transmitted and reinforced through ritual behavior.

Through my in depth investigation of the wedding ritual, I raise questions about the expectations of perfection that are
feverishly propagated by the wedding industry and eagerly consumed and self-imposed by American brides. I focus on the
iconography of the wedding dress, which serves as a metaphor for the valorization of the quest for perfection in contemporary
American wedding culture, and the resulting perfection hysteria that often ensues as brides straddle public and private life,
struggling to find a balance between personal decisions and societal expectations.




<h1>-<h6>

Header 1- Header 6

<html xmlns="http://www.w3.0rg/1999/xhtml">
<hl>.....</h1> %o T
<title>Headings Example</title> .
</head> Type Design h1
<h2>.....</h2> &
<h1>Type Design</hl> Serif h2

<h3>.....</h3>  soseriroms

Serif typefaces have small slabs at the ends of letter strokes. In general, serif fonts can make large amouns of te

<h4> </h4> <p>Serif typefaces have small slabs at the ends of let Baskerville h3
------ In general, serif fonts can make large amouns of text €
Description h4
< h 5 S </ h 5 > <h3>Baskerville</h3> - '
...... Description of the Baskerville typeface.
<h4>Description</h4> ) ha
< h 6 > </h 6> <p>Description of the Baskerville typeface.</p> History
<h4>History</h4> History of the Baskerville typeface.

<p>History of the Baskerville typeface.</p> Georgia h3

<h3>Georgia</h3> Description and history of the Georgia typeface.
<p>Description and history of the Georgia typeface.</p>

</body>
</html>

Headings are used to provide logical hierarchy or outline to a document.
Always start with the first level (h1) and work down in numerical order.

Use level headings consistently throughout your site. For example use h1 for all Article Titles.



<h1l>-<h6>
Header 1- Header 6

Everything you've always wanted to know about Amy Pierce
Bio

Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video camera, and loads of fake blood.
Later she moved to Connecticut where she got made fun of for having a weird accent and learned to take pictures. After most likely
spending an unhealthy amount of time in the darkroom, printing a myriad of self-initiated projects, she received a BFA from the
University of Connecticut. Directly following she was off to New York City where she started her own business and worked as a
commercial and editorial photographer for over 10 years, while simultaneously developing her artistic vision.

She has continued to shoot and publish work for clients that include: AﬂET, BBDO, Anglo Irish Bank, Phillips de Pury E Co., Random
House, Pantheon Books, Gianluca Isaia, Tishman Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus, Velvet Park,
XLR8R, DIW, TRACE, and L'ETOILE magazines.

She has had photographs exhibited in group shows throughout the New York area, including one at the Brooklyn Museum and the Museum of
Sex in New York City. Her short film, Maypole, was an official selection of Independent Film Project's short film screening and has
been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program at the University of Maine and is
excitedly engaging in new creative territory.

Creative Statement

As an interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and transformational moments. By
reframing components of popular and often unquestioned rituals through the integration of performance, installation, textile,
photography, videography, sound, graphic design, and audience engagement within the flexible parameters of structured created narratives
, I urge the viewer to challenge the roles society and self play in constructing identity and to rethink established conventions that
are blindly transmitted and reinforced through ritual behavior.

Through my in depth investigation of the wedding ritual, I raise questions about the expectations of perfection that are feverishly
propagated by the wedding industry and eagerly consumed and self-imposed by American brides. I focus on the iconography of the wedding
dress, which serves as a metaphor for the valorization of the quest for perfection in contemporary American wedding culture, and the
resulting perfection hysteria that often ensues as brides straddle public and private life, struggling to find a balance between
personal decisions and societal expectations.

</body




<p></p>

The <p> tag defines a paragraph.

The p element automatically creates some space before and after itself.
The space is automatically applied by the browser, or you can specify it in a style sheet.

<p>Serif typefaces have small slabs at the ends of letter strokes. In general,
serif fonts can make large amounts of text easier to read.</p>

<p>Sans-serif fonts do not have serif slabs; their strokes are square on the
end. Helvetica and Arial are examples of sans-serif fonts. In general, sans-

serif fonts appear sleeker and more modern.</p>



<p></p>

What Using Paragraphs Looks Like

<html xmlns="http://ww.w3.0rg/1999/xhtml">

<head>
<title-Paragraphs Example</title>
</head>
<body>
<h2>With p Tags</h2>
<p>
Lorem ipsum dolor sit amet, col
Fusce sit amet ligula vitae uri
vitae cursus diam sodales ut,
Suspendisse potenti.
</p>
<p>
Donec ornare velit ac nunc sag
pulvinar scelerisque. Mauris v
varius velit orci ac nibh. Viv
Pellentesque non nisl sem, ege
</p>
<p>
Pellentesque augue lectus, eui
volutpat eu mauris. Suspendiss
feugiat imperdiet nisl eget ma
Aliquam tempor aliquet facilis
Phasellus eget diam magna.
|</p>

<hZ>Without p Tags</hZ>

Lorem ipsum dolor sit amet, consec
Fusce sit amet ligula vitae urna p
vitae cursus diam sodales ut. Sed

Suspendisse potenti. Donec ornare

pulvinar scelerisque. Mauris vulpu
varius velit orci ac nibh. Vivamus
Pellentesque non nisl sem, eget la
volutpat eu mauris. Suspendisse ve
feugiat imperdiet nisl eget mattis
Aliquan tempor aliquet facilisis.

Phasellus eget diam magna.

</body>
</html>

With p Tags

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Morbi feugiat scelerisque bibendum. Fusce sit
amet ligula vitae urna placerat vehicula id vel lectus. Proin lobortis faucibus elit, vitae cursus diam
sodales ut. Sed quam nunc, sagittis id convallis a, congue ac felis. Suspendisse potenti.

Donec ornare velit ac nunc sagittis pretium. Sed ut eros eget enim pulvinar scelerisque. Mauris vulputate,
arcu in vulputate tempus, lacus elit ultricies enim, ut varius velit orci ac nibh. Vivamus a ante quis nisi
placerat lobortis facilisis et erat. Pellentesque non nisl sem, eget laoreet dui.

Pellentesque augue lectus, euismod eu tempus nec, volutpat eu mauris. Suspendisse velit justo, accumsan
id dignissim eu, congue eu est. Quisque feugiat imperdiet nisl eget mattis. Proin id purus a urna
elementum adipiscing eu ut ipsum. Aliquam tempor aliquet facilisis. Integer nulla justo, blandit id
hendrerit in, iaculis eu nunc. Phasellus eget diam magna.

Without p Tags

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Morbi feugiat scelerisque bibendum. Fusce sit
amet ligula vitae urna placerat vehicula id vel lectus. Proin lobortis faucibus elit, vitae cursus diam
sodales ut. Sed quam nunc, sagittis id convallis a, congue ac felis. Suspendisse potenti. Donec ornare
velit ac nunc sagittis pretium. Sed ut eros eget enim pulvinar scelerisque. Mauris vulputate, arcu in
vulputate tempus, lacus elit ultricies enim, ut varius velit orci ac nibh. Vivamus a ante quis nisi placerat
lobortis facilisis et erat. Pellentesque non nisl sem, eget laoreet dui. Pellentesque augue lectus, euismod eu
tempus nec, volutpat eu mauris. Suspendisse velit justo, accumsan id dignissim eu, congue cu est.
Quisque feugiat imperdiet nisl eget mattis. Proin id purus a urna elementum adipiscing eu ut ipsum.
Aliquam tempor aliquet facilisis. Integer nulla justo, blandit id hendrerit in, iaculis eu nunc. Phasellus eget
diam magna.
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What Using Paragraphs Looks Like

Everything you've always wanted to know about Amy Pierce
Bio

Amy Pierce was born in Yonkers, New York where she made movies with her sisters, the family video camera, and loads of fake
blood. Later she moved to Connecticut where she got made fun of for having a weird accent and learned to take pictures. After
most likely spending an unhealthy amount of time in the darkroom, printing a myriad of self-initiated projects, she received a
BFA from the University of Connecticut. Directly following she was off to New York City where she started her own business and
worked as a commercial and editorial photographer for over 10 years, while simultaneously developing her artistic vision.

She has continued to shoot and publish work for clients that include: AﬂﬂT, BBDO, Anglo Irish Bank, Phillips de Pury E Co.,
Random House, Pantheon Books, Gianluca Isaia, Tishman Speyer; The Village Voice, NY Press, Japanese Playboy, Platinum Plus,
Velvet Park, XLR8R, DIW, TRACE, and L'ETOILE magazines.

She has had photographs exhibited in group shows throughout the New York area, including one at the Brooklyn Museum and the
Museum of Sex in New York City. Her short film, Maypole, was an official selection of Independent Film Project's short film
screening and has been included in several group shows nationally. Amy is a MFA candidate in the Intermedia MFA program at the
University of Maine and is excitedly engaging in new creative territory.

Creative Statement

<p>As an interdisciplinary artist I investigate the complex cultural customs surrounding rites of passage and transformational
moments. By reframing components of popular and often unquestioned rituals through the integration of performance,
installation, textile, photography, videography, sound, graphic design, and audience engagement within the flexible parameters
of structured created narratives, I urge the viewer to challenge the roles society and self play in constructing identity and
to rethink established conventions that are blindly transmitted and reinforced through ritual behavior.

Through my in depth investigation of the wedding ritual, I raise questions about the expectations of perfection that are
feverishly propagated by the wedding industry and eagerly consumed and self-imposed by American brides. I focus on the
iconography of the wedding dress, which serves as a metaphor for the valorization of the quest for perfection in contemporary
American wedding culture, and the resulting perfection hysteria that often ensues as brides straddle public and private life,
struggling to find a balance between personal decisions and societal expectations.
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€ filey//cy
10 <p>
11 This text contains<br>a line break. This text contains
12 </p> a line break.

Because we know that the browser ignores line breaks in the source document
(unless using pre elements), we need a specific directive to tell the browser to
“add a line break here.”

The <br> tag inserts a single line break.
The <br> tag is an empty tag which means that it has no end tag.
The br element is an empty element, so it does not have any content.
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Line Break

Browsers don’t recognize white space! So this... will show up like this

Portrait of Amy Pierce taken by Adrian Buckmaster.

Portrait of Amy Pierce taken by Adrian Buckmaster. www.adrianbuckmaster.com

www.adrianbuckmaster.com

Add a Line Break and your text will display as intened.

Portrait of Amy Pierce taken by Adrian Buckmaster. www.adrianbuckmaster.com

Portrait of Amy Pierce taken by Adrian Buckmaster.
www.adrianbuckmaster.com



<l--Content Here-->

<I--This is a comment. Comments are not displayed in the browser-->

Useful for writing notes to yourself or others who will be working with your code
And
To comment out certain parts of the code while you are troubleshooting ©



<!—Your Content Here-->

Comment
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index.html

doctype html

src="media/AmyPierce_AdrianBuckmaster_web.jpg" alt="Portrait of Amy Pierce taken by Adrian Buckmaster




Sources

Used For this Presentation

Created by Amy Pierce for use in NMD100: Introduction to New Media Lab,
University of Maine, Orono, Maine

Sources:

www. http://www.umit.maine.edu/~jon_ippolito/bop/naming_conventions.html
www.w3schools.com

Lynda.com- HTMLS5 First look with James Williamson

Florida State University’s Applied Web Design with Ken Baldauf

Learning Web Design by Jennifer Niederst Robbins

Stylin” with CSS- A Designer's Guide 2nd edition by Charles Wyke-Smith



